
   LABORATORY
INVESTIGATION

MEASURING THE RATE OF PHOTOSYNTHESIS
Light and Photosynthesis

About 2.5 - 3 billion years ago a new chemical process, photosynthesis,  was evolved by a 
unicellular life form.  This first autotroph changed the planet in ways that are still astounding to all 
that think about it.  First the organism acquired the ability to produce its own food supply, it became 
the world’s first independent cell.  Then as a by-product of the food making process, oxygen, started to 
accumulate in the atmosphere.  This eventually lead to the evolution of aerobic respiration and more 
efficient energy production by evolving life. 

Studies leading to an understanding of the process of photosynthesis started as far back as 1648 
when van Helmont suggested that plants grow from water alone.  Later Priestly, 1772, discovered that 
plants repair the air injured b y burning candles.  Actually, the plants replaced the oxygen consumed by 
the burning candle.  Shortly after, Ingen-House (1778) extended Priestly’s work on plants and reported 
that they only released oxygen when illuminated and in the dark plants actually removed oxygen from 
the air of a sealed chamber.  Much later, Jean Senebier, showed that the increase in the carbon content 
of a growing plant is derived from the uptake of carbon dioxide from the air.  And, very importantly, 
the uptake of carbon dioxide is accompanied by the release of oxygen into the air.  From these and many 
more recent studies of photosynthesis it is possible to write a general chemical equation for the  process.

Light
6 CO2 + 6H20                                            C6H1206 + 6O2

Chlorophyll

In chemical language the equation tells us that six molecules of carbon dioxide combines with 6 
molecules of water to yield one molecule of sugar (glucose) and six molecules of oxygen.  It is also 
understood that the reaction only occurs in the light and within intact leaf cells containing 
chlorophyll.

In this laboratory activity you will determine the rate of photosynthesis in spinach leaves by 
measuring the amount of carbon dioxide they take up over an interval of time.  Additionally, you will  
have an opportunity to observe how CO2 levels vary during cellular respiration in plants.  The method 
to be used in this lab requires the spinach leaves to be confined in a sealed air filled chamber and 
exposed to a bright source of light.  While the leaves are confined in the chamber a sensor measures the 
concentration of carbon dioxide every two seconds.  An electrical signal generated by the sensor in 
response to changing carbon dioxide levels is sent to the computer for storage and display. 

Using this experimental procedure you are asked to measure the rate of photosynthesis of spinach 
leaves under varying light intensities.  Think about the following questions.  What change would you 
expect if the light intensity is low?  What change would you expect if the light intensity is high? 
What change would you expect if there is no light at all?  Develop a hypothesis that predicts the 
effect of light intensity on the rate of photosynthesis.  Write your hypothesis after item 1 in the 
analysis section of the investigation.
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Vernier Equipment
CO2 sensor, LabPro interface
Materials
Spinach leaves, plastic screens, aluminum foil, 100 watt soft white lamp, photosynthesis chamber, 500 
ml beaker, 1 pint Ziploc freezer bag, and paper towels.

Safety 
Wear safety goggles during this investigation.  An apron should be worn to protect your clothing.  The 
light bulb used during this experiment will get very hot. Do not handle the bulb. 
    

LabPro Sensor background information:

Leaf carbon dioxide intake is measured directly using the carbon dioxide gas sensor.  Measurement, by 
the sensor,  is based on the knowledge that carbon dioxide gas absorbs infrared (IR) radiation.  The 
sensor produces IR radiation from a hot filament.  The IR radiation travels through air for a short 
distance from the filament to a detector, for IR.  Carbon dioxide gas in the air path between the IR 
producing filament and the IR sensing detector decreases the electrical output of the carbon dioxide 
sensor.  The LabPro computer interface converts the electrical output of the sensor into a digital value 
that is carried to the computer via the USB cable.  Computer Logger Pro software stores the carbon 
dioxide values in a table and plots a graph of the carbon dioxide change with time.  The carbon dioxide 
sensor you will use is sensitive to concentrations of the gas between 0 and 5000 parts per million (ppm). 
The carbon dioxide concentration in the earth’s atmosphere is around 370 ppm.  Your breath could have 
concentrations as high as 50,000 ppm.

Page 2



Procedure

1. Check your computer lab station equipment for the following connections.  The cable of the 
carbon dioxide sensor is plugged into LabPro channel 1 (ch1).  The LabPro power supply is 
plugged into the LabPro AC adaptor port and a 110 volt outlet.  The USB cable is plugged into 
the LabPro and the computer USB port.

2. Remove the lid of the photosynthesis chamber.  Check to see that the CO2 sensor is firmly 
seated into the opening of the chamber.  If not, twist the stopper gently to seal the sensor and 
chamber opening.  DO NOT TWIST THE SENSOR ITSELF OR YOU MAY DAMAGE IT.

3. Start the data collection software by double clicking on the LabPro icon found on the desk top.  
A data table and graph appears on the screen.  The Y axis of the graph is labeled CO2 ppm and 
the X axis is labeled Time (sec).  The Collect button at the top of the screen is highlighted.  If 
this is the case proceed to step 5.  If the computer did not detect the carbon dioxide gas sensor 
the graph will not be labeled and the Collect button will be faded.  In this case proceed to step 
4.

4. Single click on the LabPro button.  A new window appears showing the LabPro image and CH 
information.  Click and hold on the gray CH button.  Drag to Chose Sensor and hold.  Drag to 
CO2 gas and release.  Now the CH1 display is titled CO2 gas and a CO2 reading is shown 
below the title.  Finally, close the sensor window. 

5. At this point the monitor window is divided into two windows.  The left window contains the 
table for recording the carbon dioxide readings.  The right window  contains the graph where 
the carbon dioxide readings will be plotted.  Both the table and graph have titles and labels. 
You are now ready to start data collection.  Begin by single clicking the Collect button. 

6. Clicking the collect button begins the warm-up of the CO2 sensor and  initiates the collection of 
data.  One data sample is taken every two seconds for 600 seconds.  The warm-up process takes 
90 seconds to 120 seconds before the data readings are stable.

7. Change the scale of the Y axis by clicking on the number 5000 at the top of the axis.  Clicking on 
the number causes a highlighted area to appear.  Type the number 2000 in the highlighted 
area.  Next, click anywhere in the graph.  The axis now reads from 0 ppm to 2000 ppm.

8. While you are waiting for the data readings to stabilize obtain 4 - 5 spinach leaves.  Using a 
paper towel, remove any surface moisture from the leaves. Mass the leaves and only use 10 
grams of the spinach leaves for the experiment.  Arrange the leaves so that they cover the 
entire inner lower surface of the photosynthesis chamber.   It does not matter if there is some 
overlapping of the leaf surfaces.  Place the leaves so that the darker green surface of the leaf is 
up and the lighter green surface is down.  Do not press the leaves down against the chamber’s 
lower surface.  Replace the chamber cover. 

9. Add 400 ml of cold tap water to the 1 pint Ziploc storage bag.  Seal the bag and place it on the 
cover of the photosynthesis chamber.  

10. Set up the lamp so that the bottom of the light fixture is 17 cm. above the lab table.  Turn on 
your lamp and place it over the photosynthesis chamber.  Make sure that the light fixture is 
parallel to the photosynthesis chamber and bag so that the spinach leaves will receive the 
maximum amount of illumination.  See Figure 1.  The positions of the light and chamber must be 
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kept constant during the data collection process.

11. Click the Stop button.  Click on the Experiment menu item and drag to Clear Latest Run, then 
release.  The data table and graph are clear for a new run.

12. Click the Collect button to begin measuring any change in the chamber’s CO2 level.  Collect 
data for the full 600 seconds or until the data goes off screen.  Data collection will stop 
automatically at 600 seconds.

13. After data collection stops, click on the Experiment menu item and drag to Store Latest Run.  
Next, click on the Insert menu item and drag to Text annotation.  A box with an arrow will 
appear on your graph.  You can move the cursor around the box until a hand appears.  You can use 
the hand to drag the box wherever the box fits well on the graph.  You can also grab the end of 
the arrow with a hand to adjust its alignment with the line on the graph.  Using the space in 
the box, label your graph line appropriately.

14. Remove the cover of the chamber without moving the chamber. Fan fresh air into the chamber 
for three minutes.  Additionally, in order to clear the CO2 sensor sufficiently, you should 
carefully remove it from the chamber and let the sensor sit on the lab table.  Click on the 
Collect button and watch the graph on the computer.  When the sensor reading  returns to the 
base line reading of the first experiment (or very close), you are ready to continue.  It might 
help to fan the CO2 sensor while you are fanning the chamber.  Add fresh tap water to the 
Ziploc bag. Replace CO2 sensor carefully.  DO NOT TWIST THE SENSOR ITSELF OR YOU 
MAY DAMAGE IT.  Replace the cover to the chamber and place the bag on top of the chamber.

15. You will now repeat the procedure using wire screens to decrease light intensity.  These screens 
should be placed below the Ziploc bag and above the chamber.  Your teacher will assign the 
number of screens for you to use.   Repeat steps 10 to 14.

16. You will repeat the procedure again using a layer of aluminum foil between the bag and the 
photosynthesis chamber.  Repeat steps 10 to 14.

17. Remove the aluminum foil. Remove the cover of the chamber without moving the chamber.  
Remove the leaves from the chamber.  Repeat steps 10 to 14  with the spinach leaves removed.

18.  Click on the Insert menu item and drag to Text annotation.  A box with an arrow will appear on 
your graph.  Delete the arrow by clicking on the arrow and pushing the delete button on your 
computers key board.  Move the box to the bottom of the graph and type your name and your 
partners names in the box.  Click and hold on the File menu option.  Drag to Print Graph, 
release.

19. Close Logger Pro.  Do not turn off the computer unless told to do so by your teacher.  Return the 
spinach leaves to the supply area. Clean up your laboratory work space and leave the 
equipment assembled and as it was found when you entered the area.

20. Find the slope of the linear portion of each graph line. Note that your readings were recorded 
in ppm/second.  You need to onvert your readings to ppm/minute.  Record the slope value in 
Table 1. 

Analysis
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1. Write your hypothesis statement in proper form.

2. You should have a graph with several lines representing different light intensities and a 
control.  Which variable is plotted on the X axis?  Y axis?

3. Plot a bar graph of light intensity  vs. the rate of photosynthesis.  Provide a title for the 
graph.  Label the axes of the graph with appropriate variable names. 

4. Identify the conditions of this experiment that were held constant.  What condition was 
varied?

5. Did this experiment have a control?  What was the control?

6. Examine your original hypothesis.  Does your data support or contradict your hypothesis?

7. Write a summary of this investigation.  Examine the data and the graphs for changes and 
trends.  In a paragraph describe the change in the rate of photosynthesis as the light intensity 
is changed by the addition of screens.  Explain what happened to the CO2 levels  when foil was 
placed over the photosynthesis chamber.  Why did this change occur?  Tell the reader what 
you learned about the process of photosynthesis in Spinach.

Going Further
1. Design and do an experiment to find out if the color of light changes the consumption of carbon 

dioxide by spinach. Try using green, red, blue and yellow filters.

2. Design and do an experiment to find out if there is a threshold beyond which an increase in 
light intensity does not increase the rate of carbon dioxide consumption.

Page 5



0%

No Spinach Leaves

Foil

15%

40%

25%

4

3

2

65%1

100%0

Carbon Dioxide Consumed (ppm/min)Light Intensity (%)Number of Screen

Table 1:  Carbon dioxide Consumption at Various Light Intensities
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